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Contacting NetScout Systems

Customer Support
The best way to contact Customer Support is to submit a Support Request:
http://netscout.custhelp.com/cgi-bin/netscout.cfg/php/enduser/ask.php

Telephone: In the US, call 888-357-7667; outside the US, call 
+011 978-614-4000. Phone support hours are 8 a.m. to 8 p.m. Eastern Standard 
Time (EST). 
When calling, know the following:
     — Type of network platform
     — Software and firmware versions
     — Probe model number
     — License number and your organization’s name
E-mail: support@netscout.com

Sales
Call 800-357-7666 for the sales office nearest your location.

E-Services
Website Address: www.netscout.com/support

All NetScout Customers — You can access the Self-Help Center, use your coupon 
to register and activate your nGenius Performance Manager Product, or e-mail 
Customer Support.
MasterCare Customers — You can obtain the latest software patches and 
upgrades, or access the latest documentation by logging in using your MasterCare 
number.

Training
For end-user and partners training information, and online course listings, access 
the Training website link:
www.netscout.com/training

User Forum
Website Address: www.netscoutuserforum.com/
Provides access to a customer-driven user group connecting the growing worldwide 
community of NetScout users.
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http://netscout.custhelp.com/cgi-bin/netscout.cfg/php/enduser/ask.php
www.netscout.com/support
www.netscout.com/support
http://www.netscout.com/support


iv



Contents
Introduction  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1
Installing Version 2.0.1 Service Pack 1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2
Installing the Service Pack  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

Installing From the CD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3
Downloading and Installing the Service Pack . . . . . . . . . . . . . . . . . . . . . . 5

Installation and Migration  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7
Probe Agent Firmware/nGenius Performance Manager Compatibility . . . . . . . 13
Recommended System Configurations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

Supported Platforms . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14
Disk Space Guidelines . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16
Hardware Recommendations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

New Device Support  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20
Compatibilities  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21
New Features and Enhancements in Service Pack 1 . . . . . . . . . . . . . . . . . . . . . 22
New and Revised Icons  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
Special Considerations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29

Displaying Colors on IBM Clients . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29
Documentation Additions and Corrections . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30

Citrix Test Considerations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 30
Number of Workspaces  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 32
Understanding QuickViews . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Launching QuickViews . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33
Creating QuickViews . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 33

Known Issues . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 35
Resolved Issues  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 40
Related Information Resources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 42
v



vi



nGenius Performance Manager v2.0.1
Service Pack 1 Release Notes

Introduction

This document describes new functionality, new features and enhancements, 
new device support, and resolved issues in nGenius® Performance Manager 
v2.0.1 Service Pack 1. NetScout® Systems strongly recommends that you read 
this document, as well as the nGenius Performance Manager v2.0.1 Release 
Notes, in their entirety before you install the software.

The nGenius Performance Manager application is a web-based, multi-user 
performance management system that collects, processes, and reports targeted 
network performance data, both globally and in detail. The integrated toolset for 
monitoring and reporting allows users to effectively assess and proactively 
manage enterprise networks to enable uninterrupted network services.

Underlying the new features in nGenius Performance Manager v2.0.1 Service 
Pack 1 is the NetScout Systems proprietary technology for network performance 
management called Common Data Model (CDM™). CDM allows you to collect 
network traffic data for any network topology or application and display it 
through a single integrated application.

The nGenius Performance Manager v2.0.1 Service Pack 1 release supports 
probes containing NSP v5.2, NSP v6.0.x, or CDM v2.x, or a mixed environment 
containing any combination thereof. 

Refer to the appropriate probe documentation, Probe Agent Administrator 
Guides, and Release Notes for details relating to agent firmware functionality 
and required configurations.

Important: You can view important documentation updates on the NetScout 
support website at www.netscout.com/support/. You must be a MasterCare 
customer to access documentation online. 
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Installing Version 2.0.1 Service Pack 1

Version: Release 2.0.1 Service Pack 1

Platforms: Windows 2000 Professional, Server, and Advanced Server, Solaris 
2.7, 2.8, and 2.9, IBM/AIX 5.2, HP/UX 11.0

Bugs Fixed in Service Pack 1: NSD00016008, NSD00015991, NSD00015968, 
NSD00015918, NSD00015749, NSD00015747, NSD00015707, NSD00015663, 
NSD00015531, NSD00015365, NSD00015315, NSD00015274, NSD00015217, 
NSD00015183, NSD00015178, NSD00015176, NSD00015154, NSD00015082, 
NSD00015023, NSD00014992, NSD00014987, NSD00014982, NSD00014976, 
NSD00014953, NSD00014853, NSD00014728, NSD00014311, NSD00014065, 
NSD00014008, NSD00013996, NSD00013446

Installing the Service Pack

This Service Pack supports software upgrades from nGenius Performance 
Manager v2.0.1 only. If you have not upgraded to the v2.0.1 level, you must do 
so before installing Service Pack 1.

The nGenius Performance Manager v2.0.1 Service Pack 1 upgrades the following 
software to Service Pack 1:

• nGenius Performance Manager v2.0.1

• Remote NewsStand v3.2.1

• Remote nGenius Command Line Interface (nGeniusCLI) v2.0.1

• Active Agent and Active Agent Manager v2.0.1
2 Installing Version 2.0.1 Service Pack 1



Installing the Service Pack upgrades the v2.0.1 components already existing on 
your system. For example, if your system contains the nGenius Performance 
Manager v2.0.1 Server software, the Server upgrades to v2.0.1 Service Pack 1. 
If your system contains the nGeniusCLI, the nGeniusCLI upgrades to v2.0.1 
Service Pack 1. 

To install the Service Pack, you must be the root user on UNIX systems or the 
Administrator user on Windows systems. The Service Pack must be installed on 
the same system where nGenius Performance Manager v2.0.1 was installed as 
well as on any system where the nGenius NewsStand for Remote Servers is 
installed, if included in your enterprise.

You can install Service Pack 1 using either of the following methods:

• Installing from the Service Pack CD

• Downloading the service pack from the NetScout Customer Support 
website

Installing From the CD

UNIX Platforms

1 Log in as root.

2 Stop the nGenius Server by navigating to the <nGenius install>/rtm/bin 
directory, and entering: 

./stop

3 Change to a directory where root has write permission. For example, 
change to /tmp.

Note: You must upgrade to nGenius Performance Manager v2.0.1 Service Pack 1 
before upgrading your probe to CDM v2.x. NetScout Systems strongly 
recommends that you upgrade to Service Pack 1 before you upgrade to 
NSP v6.x.x.

Important: If you are using an nGenius Express Appliance server and installing 
the Remote NewsStand, Remote nGeniusCLI, or the Active Agent on a remote 
system, you must perform the remote installation using two CDs in the following 
order: 
1 Install the remote component v2.0.1 software (CD2).

2 Apply Service Pack 1 (CD3). 
nGenius Performance Manager v2.0.1 Service Pack 1 Release Notes 3



4 Execute the following script, using the full path to the script on the CD:

pm201-sp1-unix.sh

For example, execute: /cdrom/cdrom0/pm201-sp1-unix.sh

5 Start the nGenius Server by navigating to the <nGenius install>/rtm/bin 
directory and entering:

./start

6 Confirm that all processes are running with nGenius permissions.

Windows Platforms

1 Stop the nGenius Server.

2 Check the Task Manager to verify that all processes are stopped. 

3 From the CD, execute the following file:

pm201-sp1-win.exe

4 To start the nGenius Server: From Start > Programs > NetScout nGenius 
Server, select Start nGenius Server.

5 Confirm that all processes are running with nGenius permissions.

Note: Close all other windows prior to starting the upgrade.

Note: If the dengine.exe is not stopped, locate the nGeniusNative, 
nGeniusServer, and NSApache services in Control Panel > Services 
(Windows NT) or Control Panel > Administrative Tools > Services 
(Windows 2000), change the Startup Type setting to Manual, and then shut 
down and restart your system.
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Downloading and Installing the Service Pack

You can download the Service Pack from the NetScout Systems Customer 
Support website:

www.netscout.com/support/

To access the software download area, you must enter your MasterCare number. 
If you do not have a MasterCare number, or would like to become a MasterCare 
customer, consult your NetScout Systems Sales Representative (refer to 
"Contacting NetScout Systems" on page iii for information).

UNIX Platforms

1 FTP the pm201-sp1-unix.sh file to the local machine.

2 Log in as root.

3 Stop the nGenius Server by navigating to the <nGenius install>/rtm/bin 
directory, and entering:

./stop

4 Execute the following command:

chmod 777 pm201-sp1-unix.sh

5 Execute the following script:

./pm201-sp1-unix.sh

6 Start the nGenius Server by navigating to the <nGenius install>/rtm/bin 
directory and entering:

./start

Note: Be sure to FTP the file in binary mode.
nGenius Performance Manager v2.0.1 Service Pack 1 Release Notes 5



Windows Platforms

1 Stop the nGenius Server.

2 Check the Task Manager to verify that all processes are stopped. 

3 FTP the pm201-sp1-win.exe file to the local machine.

4 Execute the following file:

pm201-sp1-win.exe

5 To start the nGenius Server: From Start > Programs > NetScout nGenius 
Server, select Start nGenius Server.

Note: Close all other windows prior to starting the upgrade.

Note: If the dengine.exe is not stopped, locate the nGeniusNative, 
nGeniusServer, and NSApache services in Control Panel > Services 
(Windows NT) or Control Panel > Administrative Tools > Services 
(Windows 2000), change the Startup Type setting to Manual, and then shut 
down and restart your system.

Note: Be sure to FTP the file in binary mode.
6 Installing the Service Pack



Installation and Migration
This Service Pack supports upgrades from nGenius Performance Manager v2.0.1 
only. 

If you are upgrading from nGenius Performance Manager v1.4 to nGenius 
Performance Manager v2.0.1 Service Pack 1, you must first successfully 
upgrade and migrate to a stable nGenius Performance Manager v2.0.1 
environment. For information about upgrading to nGenius Performance Manager 
v2.0.1 from nGenius Performance Manager v1.4, refer to the nGenius Planning 
and Migration Guide. 

For information about upgrading to nGenius Performance Manager v2.0.1 from 
nGenius Performance Manager v2.0, refer to nGenius Performance Manager v2.0 
to v2.0.1 Migration.

Table 1 summarizes some important installation, database, distributed server 
environment, and general migration issues when upgrading to nGenius 
Performance Manager v2.0.1 Service Pack 1.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description

Installation

Can I install Service 
Pack 1 directly to 
previous versions of 
nGenius Performance 
Manager, nGenius 
Real-Time Monitor, or 
any other NetScout 
Systems client?

No. Before installing Service Pack 1, you must first 
upgrade any nGenius Real-Time Monitor 
installations to the nGenius Performance 
Manager v1.4 Service Pack 8 or higher level, then 
upgrade nGenius Performance Manager v1.4 or 
nGenius Performance Manager v2.0 to nGenius 
Performance Manager v2.0.1.

Refer to the nGenius Performance Manager 
Planning and Migration Guide for upgrading to 
nGenius Performance Manager v1.4 and the 
nGenius Planning and Migration Guide for 
upgrading to nGenius Performance 
Manager v2.0.1.
nGenius Performance Manager v2.0.1 Service Pack 1 Release Notes 7



Does the Service Pack 1 
installation retain, 
upgrade, or migrate the 
Enterprise Application 
Analysis Option or the 
Web Content Analysis 
Option from nGenius 
Performance 
Manager v1.4?

No. In nGenius Performance Manager v2.0.1 the 
Universal Response Time (URT) MIB replaces the 
functionality in the Enterprise Application Analysis 
Option and the Web Content Analysis Option.

Table 2-1 in the nGenius Planning and Migration 
Guide (Rev B) lists the changes in nGenius 
Performance Manager v2.0.1 that replace the 
Enterprise Application Analysis Option or the Web 
Content Analysis Option

How much temporary 
space does the Service 
Pack 1 installation 
require?

Windows: 100 Mb

UNIX: 150 Mb

If your temporary directory does not have the 
required space, the Service Pack 1 installation 
prompts you for a temporary space location to 
satisfy the requirement.

(Windows 2000 Only) 
Can I install Service 
Pack 1 using a cloned 
version of the 
Administrator account?

No. You must use the original Administrator 
account when installing Service Pack 1.

(Windows 2000 only) 
Can I install Service 
Pack 1 with other 
windows open or other 
applications running?

No. You must stop the nGenius Server and exit all 
other windows and applications before installing 
Service Pack 1.

How long does the 
Service Pack 1 
installation take?

The Service Pack 1 installation includes upgrading 
the database from the nGenius Performance 
Manager v2.0.1 level to the Service Pack 1 level. 
This database upgrade takes (on average) one 
minute per gigabyte of data.

Is there any loss of 
functionality after 
installing Service 
Pack 1?

No.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
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Should I install Service 
Pack 1 before upgrading 
any probes to NSP 6.0.2 
or CDM 2.1?

Yes. You may lose historical data and 
proxyapports if you upgrade your probes before 
installing Service Pack 1. The following agent 
firmware limitations also apply:

• CDM 2.1: Compatible only with nGenius 
Performance Manager v2.0.1 with Service 
Pack 1.

• NSP 6.0.2: You must remap proxyapport 
settings or the old aggregation interface 
(ifn 49) if upgrading from NSP 5.2.

Do Fibre Channel SAN 
probes (98xx) support 
Site Monitoring, Host 
Grouping, or QOS 
Monitoring interfaces.

No.

Database

What database version 
does the Service Pack 1 
installation apply to?

The Service Pack 1 installation applies only to an 
nGenius Performance Manager v2.0.1 level 
database.

Refer to the nGenius Performance Manager 
Planning and Migration Guide for upgrading a 
database to the nGenius Performance 
Manager v1.4 level and the nGenius Planning and 
Migration Guide for upgrading a database to the 
nGenius Performance Manager v2.0.1 level.

Will nGenius 
Performance 
Manager v2.0.1 Service 
Pack 1 function with a 
previous version 
database from nGenius 
Performance Manager, 
nGenius Real-Time 
Monitor, or other 
NetScout Systems 
client?

No. You must upgrade the database to the 
nGenius Performance Manager v2.0.1 Service 
Pack 1 level.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
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Should I back up my 
database before 
installing Service 
Pack 1?

Yes. Refer to the nGenius Performance Manager 
Administrator Reference Guide for details on 
database backup.

What are the upgrade 
implications for a 
database in a custom 
location?

If the pm_env (.bat or .sh) and 
serverprivate.properties files note the custom 
database location, the Service Pack 1 installation 
upgrades the database automatically.

If you have never started the nGenius Server, the 
database does not yet exist. When you start the 
nGenius Server for the first time, nGenius 
Performance Manager v2.0.1 creates the database 
at the Service Pack 1 level.

If the database is in a 
custom location, does 
the Service Pack 1 
installation require a 
substitute stealth.db file 
in the rtm/database 
directory (default 
location)?

No.

How long does it take to 
upgrade an nGenius 
Performance 
Manager v2.0.1 
database to the Service 
Pack 1 level?

The Service Pack 1 installation includes upgrading 
the database from the nGenius Performance 
Manager v2.0.1 level to the Service Pack 1 level. 
This database upgrade takes (on average) one 
minute per gigabyte of data.

How can I monitor the 
progress and results of 
the database upgrade?

The rtm/log/dbpatch.log file records the progress 
and results of the database upgrade.

What must I do if I 
receive the following 
message when installing 
Service Pack 1?

"Database was created 
with older software 
and may benefit from 
being rebuilt"

Ignore this message. You are not required to 
perform any additional action.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
10 Installing the Service Pack



Distributed Servers

Must I install Service 
Pack 1 on all nGenius 
Servers?

Yes. All nGenius Servers in a distributed servers 
environment must be at the nGenius Performance 
Manager v2.0.1 Service Pack 1 level to function 
properly as a distributed server.

What is the correct 
sequence for installing 
Service Pack 1 in a 
distributed servers 
environment?

Installing Service Pack 1 on the Global Manager 
first provides two benefits:

• Global Settings in the Global Manager can 
immediately apply to all Local Servers that 
you upgrade

• Direct access to Local Servers is possible, but 
not from the Global Manager until the Local 
Servers are at the same build as Global 
Manager.

After installing Service Pack 1 on the Global 
Manager, you can install Service Pack 1 on all 
Local Servers in any order.

Migration (software and firmware)

Does the Service Pack 1 
installation migrate 
existing custom filters, 
including post-capture 
filters, automatically?

Yes.

Does the Service Pack 1 
installation migrate 
custom TCP and UDP 
ports greater than 
48000 in nGenius 
Performance 
Manager v2.0.1?

This migration does not apply to nGenius 
Performance Manager v2.0.1 and was needed only 
for upgrading from nGenius Performance 
Manager v1.4.

Does the Service Pack 1 
installation migrate 
existing raw and logged 
data from nGenius 
Performance 
Manager v2.0.1?

Yes.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
nGenius Performance Manager v2.0.1 Service Pack 1 Release Notes 11



What does the Service 
Pack 1 installation do 
with existing half-duplex 
interfaces and new 
support for full-duplex 
interfaces?

Full-duplex data displays as In vs. Out and any 
existing half-duplex data displays as Total.

Does the Service Pack 1 
installation overwrite 
any custom 
configuration settings or 
must I modify any 
configuration settings in 
Server Administration 
after installing Service 
Pack 1?

No.

What probe models 
support upgrading to 
CDM 2.1?

• All 2000 series
• 9000 series except 9001, 9002, 9003, and 

9011

What settings or values 
must I record for 
reconfiguration before 
upgrading probe agent 
firmware?

• Application Recognition Server Mask
• Aggregated Gigabit Ethernet Mapping
• NetFlow Interface Settings
• Probe Mode (Fast Ethernet, Gigabit Ethernet, 

and Fibre Channel SAN probes)
• Network Security Adaptor (NSA) configuration 

settings for NSP 5.x probes with nGenius Flow 
Director support

Refer to the nGenius Planning and Migration Guide 
for more information.

Does nGenius 
Performance Manager 
retain probe 
proxyapport definitions 
above port 48000 when 
upgrading probe agent 
firmware to NSP 6.0.2 
or CDM 2.1?

Yes. If upgrading from NSP 6.0.1 or NSP 6.0, 
nGenius Performance Manager retains these 
definitions.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
12 Installing the Service Pack



Probe Agent Firmware/nGenius Performance 
Manager Compatibility

For additional information on probe compatibility and issues described in Table 2 
refer to the nGenius Probe Agent Administrator Guide for the applicable agent 
firmware version.

After installing Service 
Pack 1, what are the 
issues when 
downgrading probe 
agent firmware from 
NSP 6.0.2 or CDM 2.1 to 
NSP 5.x?

NSP 6.0.2 or CDM 2.1 functionality is no longer 
accessible and only RMON1 and RMON2 data 
remains.

If you downgrade a CDM 2.1 probe configured for 
virtual interfaces then upgrade to CDM 2.1 again, 
Global Settings in the nGenius Performance 
Manager retains the previously configured virtual 
interfaces and historical data.

Table 2  Firmware/nGenius Performance Manager Compatibility

Products

nGenius 
Performance 
Manager v1.4

nGenius 
Performance 

Manager v2.0.1

nGenius 
Performance 

Manager v2.0.1 
with 

Service Pack 1

NSP 5.2 Yes RMON1/RMON2 RMON1/RMON2

NSP 6.0 RMON1/RMON2 Yes Yes

NSP 6.0.1 RMON1/RMON2 Yes Yes

NSP 6.0.2 RMON1/RMON2 *Yes *Yes

CDM 2.1 No No Yes

* In NSP 6.0.2 NetFlow is not supported on 8000 series probes.
URL Monitoring is not supported in NSP 6.0.2.

Table 1  Upgrading to nGenius Performance Manager v2.0.1 Service Pack 1

Topic Description
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Recommended System Configurations
The tables in this section list recommended system configurations for nGenius 
software.

Supported Platforms

Note: 
• NetScout nGenius products are designed and tested on dedicated servers. 

Third-party network management software, database agents, port scanners, 
and security software installed on the same server may lead to port conflicts and 
compromise the behavior and performance of the nGenius products.

• Ensure that you have a minimum of 100 MB (Windows platforms) or 150 MB 
(UNIX platforms) of available space in your /tmp or Temp directory before 
installing nGenius Performance Manager.

• Some virus scan software can cause locking problems on database servers. For 
best results on Windows platforms, exclude the database directory from your 
virus scan.

Table 3  Server and Client Support for Version 2.0.1

Component Recommendation

Server • Windows 2000 Professional, Server, and 
Advanced Server with Service Pack 3 or 4 
(English, Japanese, Korean, Chinese)

• Solaris v2.7, 2.8, and 2.9 with appropriate patch 
level to support Java 1.4.1_02 (English, 
Japanese)

• HP/UX v11.0

• IBM/AIX v5.2

Client • Microsoft Windows 2000 Professional, Server, or 
Advanced Server with Service Pack 3 or 4 
(English, Japanese, Korean, Chinese)

• Windows XP with Service Pack 1 (English)

• Solaris v2.7, 2.8, and 2.9 (English, Japanese)

• HP/UX v11.0 (English)

• IBM/AIX v5.2 (English)

• Java Plug-in v1.4.1_02 or v1.4.1_05

Review the nGenius Performance Manager Installation Guide for all required 
operating system patches. Links to all nGenius patches, JRE, and Java 
plug-ins are available from www.netscout.com/support. 
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Table 4  Client Browser Support by Platform

Browser Windows

Solaris

AIX HP/UXv2.7 v2.8 v2.9

Internet Explorer 
v5.5

Yes Yes Yes No No Yes

Internet Explorer 
v6.0

Yes N/A N/A N/A N/A N/A

NetScape v6.2.3 Yes Yes Yes Yes Yes No

NetScape v7.x Yes Yes Yes Yes Yes No

Mozilla v1.4 No No No No No Yes

Note: All browser versions require JRE v1.4
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Disk Space Guidelines

Refer to Table 5 for disk space guidelines.

The actual amount of disk space you require depends on the following factors:

• Will backups be performed on the disk on which the nGenius software is 
installed? If so, double the recommendations in Table 5.

• Will you use RAID 5, RAID1, or RAID 1+0? 

– RAID 1 or RAID 1+0 — Double the disk space in Table 5 to provide 
space for mirroring.

– RAID 5 — Provide an additional disk to provide space for managing 
the data redundancy scheme.

• Will NewsPapers be stored on the same disk? If so, refer to Table 5, and 
increase disk space accordingly.

• Do you plan to store trace files on the same disk? What size and number 
of NewsPapers and trace files do you anticipate? Refer to Table 5, and 
increase your disk space accordingly.

Table 5  Disk Space Guidelines

Load
nGenius 
Database

NewsPapers 
and Trace Files

Available 
Disk 

Space

• 50 Physical Interfaces

• 500 Virtual Circuits

• 9500 switch or MIB2 ports

• 10 NewsPapers

90 GB 50 GB 140 GB

• 100 Physical Interfaces

• 1000 Virtual Circuits

• 19,000 switch or MIB2 ports

• 20 NewsPapers

180 GB 100 GB 280 GB
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Hardware Recommendations

NetScout Systems recommends the hardware configurations detailed in Table 6 
and Table 7.

nGenius Server 

Note: One license includes 50 Type 1 and 10,000 Type 2 monitored 
elements. 
Type 1 — Physical interfaces, Network Analysis Module (NAM) interfaces, 
and CDM adaptors (Link Aggregation, Probe [Gigachannel] Aggregation, or 
High-Speed Aggregation, NetFlow, sFlow).
Type 2 — Any combination of the following: Virtual interfaces (VLAN, DLCI, 
ATM PVC, QoS, VSAN, Site, Site QoS, Native QoS, netflow/sFlow router 
Qos), virtual interfaces of NetFlow and sFlow, Fast EtherChannel (FEC) and 
NAM NetFlow, device interfaces such as MIB2, Frame Relay MIB DLCI, and 
mini-RMON switch ports.
To increase the number of elements you can monitor, purchase additional 
licenses. Do not reinstall the application. Refer to the nGenius Performance 
Manager Installation Guide for specific information about incremental 
licensing.

Table 6  nGenius Server  

nGenius Performance Manager v2.0.1

Windows 2000 Platforms — One License

Processor
Memory
RAID
I/O 
Subsystem
Media
Network Card
IP Address
File system

Dual Xeon processors, 2.8 GHz with 512K cache
4 GB SDRAM, 4 x 1 GB DDR SDRAM
Single-channel 128MB cache with write-back cache; configured 
RAID 5
Three or four 73 GB 10,000 or 15,000 rpm ULTRA 320 SCSI hard 
drives
CD-ROM drive
10/100 Ethernet adaptor
Static IP address
For Windows platforms, use the NTFS-formatted hard disk 
instead of the FAT to ensure appropriate security.

• To determine your file system, open Windows Explorer and 
right-click <drive> > Properties.

• You can convert from FAT to NTFS at any time. Refer to the 
applicable Microsoft documentation for appropriate 
procedures.
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Windows 2000 Platforms — Two Licenses

Processor
Memory
RAID
I/O 
Subsystem
Media
Network 
Cards
IP Address
File system

Dual Xeon processors, 2.8 GHz with 512K cache
8 GB SDRAM, 4 x 2 GB DDR SDRAM
Single-channel 128 MB cache with write-back cache; configured 
RAID 5
Five 73 GB 15,000 rpm ULTRA 320 SCSI hard drives
CD-ROM drive
10/100 Ethernet adaptor
Static IP address
For Windows platforms, use the NTFS-formatted hard disk 
instead of the FAT to ensure appropriate security.

• To determine your file system, open Windows Explorer and 
right-click <drive> > Properties.

• You can convert from FAT to NTFS at any time. Refer to the 
applicable Microsoft documentation for appropriate 
procedures.

Solaris Platforms — One License

Processor
Memory
I/O 
Subsystem
RAID
Network Card
IP Address
Media Device

Dual UltraSPARC IIIi processors, 1.28 GHz with 1 MB cache
4 GB RAM
Three or four 73 GB 10,000 or 15,000 rpm Fibre Channel disks
Sun StorEdge or Hitachi RAID Array configured as RAID 5 or 0+1
10/100 Ethernet adaptor
Static IP address
CD-ROM drive

Solaris Platforms — Two Licenses

Processor
Memory
I/O 
Subsystem
RAID 
Controller
Network Card
IP Address
Media Device

Four UltraSPARC IIIi processors, 1.28 GHz with 1 MB cache
8 GB RAM
Four or Five 73 GB 15,000 rpm Fibre Channel disks
Sun StorEdge or Hitachi RAID Array configured as RAID 5 or 0+1
10/100 Ethernet adaptor
Static IP address
CD-ROM drive

Table 6  nGenius Server (Continued) 

nGenius Performance Manager v2.0.1
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Remote NewsStand

The recommendations for the Remote NewsStand are the same as for the 
nGenius Server with one license. Refer to Table 6 for specifics.

Client

The nGenius Performance Manager client consists of a Web browser with a Java 
plug-in. Refer to Table 7 for complete client recommendations.  

Note: To run nGenius Performance Manager on HP/UX, you must change 
several default kernel parameters. For a list of parameters and required 
values, refer to the nGenius Performance Manager Installation Guide. 

Note: 
• If you are viewing (not configuring) NewsPapers, the Java plug-in is not 

required.
• By default, nGenius Performance Manager uses port number 8080 for client 

HTTP connection. Ensure that no third-party software conflicts with port 
8080. For information on how to change the port number for client HTTP 
connection, refer to the nGenius Performance Manager Installation Guide.

Table 7  Client Hardware Configurations

Client Hardware Requirements

Processor
Memory
Available Disk Space
Display Settings

800 MHz or higher
512 MB or higher
250 MB or higher
1024x768 minimum and True Color (if 
supported)
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New Device Support 

Service Pack 1 adds support for the following devices:

Cisco 

• Network Analysis Module-2 v.3.1 (NAM-2 v.3.1) (second port)

• Cisco Catalyst 2940 Series IOS release 12.1(13)AY

• Cisco Catalyst 2940 Series

• Cisco Catalyst 2955, 3550 PWR, and 3750 Series IOS 
Release 12.1(14)EA1

• Cisco Catalyst 2955 Series Industrial

• Cisco Catalyst 3550 PWR Series

• Cisco Catalyst 3750 Series

• Cisco Catalyst 4500 Series Supervisor Engine II-Plus

• Cisco Catalyst 6500 Series CatOS Release 8.1

• Cisco Catalyst 6500 Series IOS Release 12.1(19)EX

• Cisco Catalyst 6500 Series IOS Release 12.2(14)SX

• Cisco Catalyst 6500 Series IOS Release 12.1(17a)SX

• Cisco Catalyst 6500 Supervisor 720
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Compatibilities

nGenius Performance Manager v2.0.1 Service Pack 1 can:

• Coexist with prior versions of nGenius Performance Manager with the 
understanding that only one product is in charge of device configuration 
and the receipt of trap information.

• Integrate with CiscoWorks 2000 Network Manager v6.1 and v6.2 (LMS 
Bundle 3.0) or HP OpenView on the same or separate machines.

• Support Cisco ACS v3.0 for support integration with TACACS 
authentication.

• Support RMON1 and RMON2 on NetScout probes running v5.2; however, 
it does not support the ART and CRT MIBs. 

• Support the following agent firmware versions:

– NSP v5.2

– NSP v6.x.x

– CDM v2.x
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New Features and Enhancements in Service 
Pack 1

Table 8 describes the new features and enhancements in nGenius Performance 
Manager v2.0.1 Service Pack 1. You can view details about new features in the 
online Help and appropriate probe documentation. 

Note: For specific information regarding probe support for the following new 
features and enhancements, refer to the applicable probe documentation. 

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1

Feature Description

New Features Supported by CDM v2.x Firmware

VSAN support The nGenius Performance Manager software now 
supports Virtual Storage Area Network (VSAN) 
technology for data capture, Console views, and 
NewsPaper articles. VSAN technology allows a Single 
Fibre Channel Fabric Switch to behave as if it were 
multiple separate fabrics. 

Site-Based monitoring In nGenius Performance Manager, virtual interface 
classification is known as Site. Site-based monitoring 
allows you to use a virtual channel to track host, 
conversation, and statistics based on a user-defined 
subnet or list of subnets. Virtual channelization is useful 
where other forms of classification are difficult or 
impossible because the target link is encrypted, not 
instrumentable, or inaccessible for flow collections. 
Applications for this feature include VPNs, MPLS, IPSec 
and carrier-created channelized links.

NetFlow/sFlow 
enhancements

Service Pack 1 includes enhanced support for NetFlow 
and sFlow interfaces including support for the following:

• Full duplex virtual interfaces

• Up to 10 Netflow routers per probe

• Mixed mode virtual classification

• Router Backbone view on parent interface, using 
pseudo-MAC addresses representing 
NetFlow-enabled router interfaces. Netflow header 
decode is optional.
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Host Grouping The Host Grouping feature in Service Pack 1 allows you 
to configure host groups and subnets. Once configured, 
all troubleshooting and reporting features currently 
available for hosts are available for host groups and 
subnets.

QoS Monitoring Extensions With CDM 2.x, the QoS monitoring in NetScout probes is 
extended to support QoS levels over virtual as well as 
physical interfaces. The QoS virtual interfaces are 
secondary to existing parent Native (DLCI, PVC, VLAN), 
user-defined (Site) virtual interfaces, or netflow/sFlow 
router QoS.

To support extended QoS monitoring, the Performance 
Manager Console now allows selection of the following 
types of virtual interfaces: Native (DLCI, PVC, VLAN), 
QoS (over trunk), SITE, Native-QoS, SITE-QoS, 
netflow/sFlow router Qos. When you select either 
Native-QoS, SITE-QoS or netflow/sFlow router QoS, the 
probe creates additional secondary virtual interfaces for 
QoS levels on the primary virtual interfaces. Up to 64 
QoS (DSCP code points) can exist on each primary 
virtual interface.

Data Source Health Data Source Health views provide information about 
CPU Utilization and Free and Used Memory for 
supported devices (Cisco routers and switches). You can 
view Data Source Health Statistics in the Performance 
Manager Console (Data Source Health Enterprise, Data 
Source Health Snapshot, and Data Source Health over 
Time views) and in the NewsPaper (Data Source Health 
Summary article).

Additional New Features

Customizing User Roles User Roles Configuration allows System Administrators 
to control functionality for each user role.

Bulk Relearn The bulk Re-Learn button has been moved to the Device 
Configuration dialog box. You can now select multiple 
devices and click Re-Learn.

Logger Memory in Server 
Health

The Server Health window (Administration > Server 
Configuration) now displays the memory consumed by 
the logger process (NSLogger). 

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1 (Continued)

Feature Description
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Device Configuration 
Health button renamed

The Health button in the Device Configuration window is 
now renamed to Information.

Change to Template 
Logging Threshold 
Manager

The Logging Threshold in the probe Template Manager 
now accepts a value of zero. (Previously, values less 
than 1 percent were not supported.)

Floating Navigation Tree You can now float or hide the Navigation tree. 

Workspace Cycling Workspace cycling allows you to cycle through your 
workspaces when the Console is unattended. Click 
View > Cycle Workspaces to select a duration. The 
duration is stored as a user preference.

View Attributes in Saved 
Workspaces

Additional view attributes are now persistent when you 
save a workspace, including the following: poll rate, 
Host IP Address or Name, Short or Long Application 
Name, sorting column and direction, and the view type 
(chart or table). 

View Status Bar Changes The Time and Refresh menus have been merged. 

Images saved as JPEGs The Save as GIF menu selection is renamed to Save as 
an Image. Images are now saved as JPEGs. Additional 
formats may be supported in the future. 

Notes in Navigation tree 
mouse over

Notes you enter in the Add Device dialog box are added 
to the information displayed when you mouse over a 
monitored element in the Navigation tree. 

Short Term History Time 
Menu

A Time Menu has been added to the Short Term History 
view to allow you to choose a refresh rate or pause the 
view.

Preference Defaults The Preferences > Display Options tab allows you to 
display Host/Device Names and the Application Name 
short version in views by default. You can override 
defaults using the Options menu. Any view attributes 
saved with workspaces also override the Display 
Options preferences.

MIB2 Discards display as 
separate Show metric

Prior to Service Pack 1, MIB2 discards were counted as 
errors and displayed as a specific error type. MIB2 
discards now display under their own Show metric, 
rather than as an error type.

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1 (Continued)

Feature Description
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MIB2 Packet Types now 
display as Non Unicast 

With Service Pack 1, Non Unicast data displays as 
Packet 
Type > Non Unicasts. (Formerly, half of Non Unicast 
data displayed as Broadcasts and half displayed as 
Multicasts.)

Support for new file 
formats in data capture

Data Capture is now supported for *.cap and *.pcap file 
formats. In addition, Service Pack 1 supports:

• Import and export of files in the *.cap and *.pcap 
formats

• Save As functionality from one format to anther 
(NetScout format to *.cap or *.pcap format or vice 
versa) in the Save Trace and Save Range of Frames 
functions of the Decode view. Sniffer *.cap or 
*.pcap formats are supported.

Imported *.pcap files initially display only start time 
information in the Trace Files view. Open the file to 
update the view with additional details such as Trace 
End Time and Total Frames.

Discovered TCP/UDP Ports You can now drill down in the Discovered TCP/UDP Ports 
table view to perform a data capture on up to four 
ports, carrying the context into filter creation. If all 
ports are of one type (either UDP or TCP) the data 
capture is filtered by application as well as port. 

Launching Filter Editor You can now launch the filter editor by double-clicking a 
file in the Filter Groups window.

Launching Decode Views You can now double-click a selected trace file to launch 
the Decode view.

Application versus Network 
Breakdown (Flight Time) 
with one probe

Flight Time views based on only one probe now display 
an application versus network breakdown. 

Most Accessed Servers by 
Responses View and 
Number of Responses over 
Time View 

These views have been updated to display a breakdown 
of successful and failed responses in a stacked bar 
format.

Response Time 
Distribution View

The Response Time Distribution view now displays in 
shades of red, yellow, and green to reflect the severity 
of each level.

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1 (Continued)

Feature Description
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New Response Time view: 
Number of 
Retransmissions Over 
Time

Retransmission data information formerly found in the 
Response Time Distribution Over Time view is now 
available in a time series view. Because retransmission 
data is not dependent on application-based time 
boundaries, the new view displays data within any 
context (for example, location, server, application, 
client).

Reporting

New articles The following new articles have been added to the 
NewsPaper:

• Circuit Interface Detailed Listing

• Data Source Health Summary

• VSAN Summary

• DLCI Downtime Summary (Situations to Watch)

• Switch Port Utilization Forecast

• Application Volume (Executive Summary)

• App Server Performance Summary

Probe Serial Number 
displayed in Asset Report

The Device Detailed Listing article (Asset Management) 
displays probe serial numbers.

Renaming and Deleting 
Local NewsPapers

The Local NewsPaper can now be renamed or deleted.

Calendar Selecting a different month in the NewsPaper calendar 
now brings you to the same day that displayed in the 
previous month.

Aggregate Article Display You can now opt to display aggregated articles only in a 
Global Manager aggregated NewsPaper. The default is to 
display a given article (for example, Most Utilized 
Segments) for each server individually in addition to 
one article that aggregates data from all servers.

Display of server name You can now configure the following options to control 
the way server names display in the article title bar:

• Show the server name only if multiple servers 
report to the NewsPaper

• Never show the server name

• Always show the server name 

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1 (Continued)

Feature Description
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New and Revised Icons

Some icons in the Performance Manager Console and Server Administrator 
interfaces have been added to support new functionality, and other icons have 
been revised. The reasons for revising icons include the following:

• Make icons consistent throughout the product

• Conform to industry standards

• Individualize icons to make them more distinguishable

• New functionality

Refer to Table 9 for a list of some revised and new icons.

Command Line Utilities

Command Line Device 
Tools

dvTools are now called Command Line Device Tools. The 
Command Line Device Tools and nGeniusCLI utilities 
now operate as independent functions. Refer to the 
nGenius Performance Manager Administrator Reference 
Guide for complete details.

Table 9  New and Revised Icons

Description v2.0 Icon v2.0.1 SP1 Icon

Server Configuration

Monitored Element Group

Database Backup

Device Configuration

Template

Configure Time Trigger

User Accounts

Newly added Protocol

Table 8  New Features and Enhancements in v2.0.1 Service Pack 1 (Continued)

Feature Description
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Switch Port

Analyzer Port with Probe 

Global Settings

Add Device

Filter Groups

Capture Status

User Roles Configuration N/A

Message Log N/A

Task Progress Report N/A

Response Time 
Configuration

N/A

Exclusions N/A

Upgrade Probes N/A

Table 9  New and Revised Icons (Continued)

Description v2.0 Icon v2.0.1 SP1 Icon
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Special Considerations

Refer to the "Special Considerations" section in the nGenius Performance 
Manager v2.0.1 Release Notes for additional important considerations when 
using the nGenius software.

Displaying Colors on IBM Clients
For IBM-AIX clients using Netscape Navigator, when you view a PDF of an Ad 
Hoc Report using Adobe Acrobat, it can fail to display colors properly. The 
following error may display:

Could not allocate enough colors, using grey scale

If you receive this error, configure the client system to support the maximum 
number of colors possible. In addition, you can use one or more of the following 
troubleshooting solutions:

Solution 1 — Start Navigator without using the -install option.

Solution 2 — Start Navigator using one of the following options to limit the 
number of colors it uses:

netscape -ncols 16
netscape -ncols 32

Solution 3 — Start the Xserver in StaticColor mode, and force Netscape to use 
the StaticColor visual:

1 If you are using OpenWin, enter the following command at the UNIX 
command prompt:

openwin -dev /dev/fb defclass StaticColor

2 Start Navigator, and reference the StaticColor visual. You can use the 
xdpyinfo command to determine the ID number. For example, enter:

netscape -visual 0x25

Solution 4 — Disable the Acrobat plug-in (nppdf.so) in the Navigator 
Preferences dialog box. Disabling the plugin causes Acrobat Reader or Acrobat 
Exchange to start as a standalone application. For more information, refer to the 
Adobe Support website.

Solution 5 — Start Acrobat Reader or Acrobat Exchange before starting 
Navigator.

Note: See your UNIX administrator if you need assistance.
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Documentation Additions and Corrections

This section describes additions and corrections to printed documentation and 
the online Help.

Citrix Test Considerations
Configuring a Citrix Active Agent test requires a manual step that is documented 
in the online Help topic "Citrix Test Considerations." The procedures in this topic 
replace those described in the online Help. 

UNIX Active Agents

To run a Citrix test successfully, the Active Agent process cannot run in the 
background. When you perform the following procedure, the Citrix test runs until 
you log out of root.

1 Log on to the Solaris Active Agent system as root. Kill the NSActive 
process.

2 If an inactivity timer is set to password protect your login session, in the 
UNIX terminal window, enter:

xhost +

3 Navigate to the/bin subdirectory where the Active Agent was installed 
(typically, /opt/ActiveAgent/activeagent/bin). 

4 Restart the Active Agent by executing ./aactl start.
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Windows Active Agents

When you initially configure a Citrix connection using Citrix Program 
Neighborhood on an Active Agent system, the APPSRV.INI file is created under 
that logged-in username. Later, when you restart your Active Agent system, the 
Active Agent runs under the default username, creating another APPSRV.INI file 
under the default username. For the Active Agent Citrix test to complete 
successfully, you must copy the APPSRV.INI file created under the logged-in 
username to the default username account.

1 Configure the Citrix Active Agent test at the Active Agent Manager, using 
the procedure described in the online Help.

2 Log on to the Active Agent system using the same account that created 
the Citrix connection with the Citrix Program Neighborhood used by the 
Active Agent Citrix test. To identify the account, navigate to the following 
directory:

Windows NT — C:\WINNT\Profiles\

Windows 2000 or XP — C:\Documents and Settings\

Search for the file APPSRV.INI. The non-Default User (NT and 2000) or 
non-LocalService (XP) directory identifies the account.

3 Navigate to the following location as appropriate:

Windows NT — C:\WINNT\Profiles\Default User\Application 
Data\ICAClient

Windows 2000 — C:\Documents and Settings\Default User\Application 
Data\ICAClient

Windows XP — C:\Documents and Settings\LocalService\Application 
Data\ICAClient

4 Rename the APPSRV.INI file to appsrv_orig.ini. 

5 To determine the logged in account name, open an MS-DOS window and 
enter the following command:

set

The USERPROFILE displays the profile directory for this account. (For 
example, C:\Documents and Settings\<logged in account name>).

6 In Windows Explorer, navigate to the following location:

Windows NT — C:\WINNT\Profiles\<logged in account 
name>\Application Data\ICAClient

Windows 2000 or XP — C:\Documents and Settings\<logged in 
account name>\Application Data\ICAClient

7 Copy the APPSRV.INI file into the appropriate directory in Step 3.

8 Reboot the Active Agent system.
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Number of Workspaces
The "Using Workspaces" section in the nGenius Express Configuration Essentials 
guide and the online Help state that the number of workspaces that can be 
displayed at one time is limited to eight. 

• The number the workspaces that can be displayed at one time is now 
four. 

• The number of workspaces you can save is unlimited.

• The number of views per workspace is unlimited; however, after you 
display 50 views across all workspaces, a message warns you that 
launching more views could affect performance. 

If you want to display more than four workspaces at one time, you must add the 
appropriate property to the common.properties file and then execute the 
nGConfigSync utility. Executing nGConfigSync modifies the appropriate property 
in the client.properties file.

1 From the nGenius Server system, navigate to <nGenius install>\config.

2 Open the common.properties file using a text editor.

3 Add the following line to the common.properties file:

max.active_workspaces=<maximum number of workspaces to display>

For example, enter:

max.active_workspace=5

4 Save and close the file.

5 Change directories to the <nGenius install>\rtm\bin directory. 

6 Execute nGConfigSync.bat (Windows) or nGConfigSync.sh (UNIX).

7 The client.properties file updates to display the new limit. For example:

# Number of active workspaces allowed

#### UPDATE *** max.active_workspaces=4

max.active_workspaces=5

Note: NetScout Systems recommends creating a backup of the file before 
making any modifications.
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Understanding QuickViews

QuickViews allow you to create and maintain a group of views that you 
frequently launch against a monitored element. Each user can create a personal 
grouping of QuickViews and each user can view only the QuickViews that they 
create. 

Launching QuickViews

To launch QuickViews, right-click a monitored element and select QuickViews. 
Select the QuickView you want to launch.

The following preconfigured QuickViews are available by default with nGenius 
Performance Manager:

• Application Visibility

• Link Analysis

• Location Performance Analysis

• Peak Analysis (Application Layer)

• Peak Analysis (Network Layer)

Creating QuickViews

You can:

• Create a QuickView from the contents of a Workspace

• Add or modify a QuickView using the File menu 

Creating a QuickView From a Workspace

To create a QuickView that consists of views open in a Workspace:

1 From the Home page, select Workspaces.

2 Right-click within a Workspace (outside any views), and select Create 
QuickView from Workspace. 

3 Enter a QuickView name (by default, the workspace name), and click OK. 

The new QuickView displays in the QuickView menu.

Note: The information in this section replaces the information in the "Saving 
Favorite Views" section on pages 3-37 and 3-38 of the nGenius Express 
Configuration Essentials guide.
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Adding or Modifying a QuickView Using the File Menu

To create a QuickView using the File menu:

1 From the Home page, select Workspaces.

2 Select File > Add/Modify QuickViews.

3 Perform one of the following:

Add new QuickView — Click Add, and enter a QuickView name in the text 
field.

Modify existing QuickView — Select a user-defined QuickView from the 
displayed list, and click Modify. 

4 Add or modify the views to be included in the QuickView:

Add views — From the Available Views list, select the view name and click 
Add. 

Remove views — From the Selected Views list, select the view name and 
click Remove. Click Remove All to remove all entries.

5 Click OK. 

New QuickViews name display in the QuickView menu.

Note: Clicking Delete removes the selected user-defined QuickView. You 
cannot modify or delete the default QuickViews provided with nGenius 
Performance Manager.
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Known Issues
Table 10  Known Issues in nGenius Performance Manager v2.0.1 SP1

Issue Description

Installation

Dynamic content-NpPortalDistributor 
SOAP service request for URL contains 
the default, rather than the correct, web 
port. (14791)

This issue occurs only when the default port 
number has been changed for remote 
NewsStands that have been upgraded from a 
previous version of nGenius Performance 
Manager.

Workaround:

1 On the remote NewsStand system, 
navigate to <Remote NewsStand 
Home>\config.

2 Open the common.properties file using a 
text editor.

3 Add the following line to the 
common.properties file:

webserverport=<port number>

For example, enter:

webserverport=8082

4 Save and close the file.

5 Stop the remote NewsStand.

6 Change directories to the <Remote 
NewsStand Home>\rtm\bin directory. 

7 Execute nGConfigSync.bat (Windows) or 
nGConfigSync.sh (UNIX).

8 Restart the remote NewsStand. 

The port number is updated in all appropriate 
property files.

Note: To determine your port number, navigate to 
<Remote NewsStand 
Home>\apache\conf\httpd.conf and search for 
"Port".

The licensing update utility 
documentation is incomplete. 

The following note should be added to the 
Installation documentation:

Note: The license.sh file must be run in the 
Xwindows environment.
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Attempting to execute the lfa.bat file 
returns an Unable to Locate DLL error. 
(16024)

The Perl.exe (which is invoked by lfa.bat) 
cannot find the driver called msvcr70.dll. 
Only machines that have never installed 
Microsoft Office are affected.

Workaround: 

Copy the driver from another machine to the 
C:\WINNT\System32 directory on the PM 
server. 

UNIX platforms — For the Remote 
NewsStand using any Web port below 
1024, Apache does not start. (14867)

1 Log in as root.

2 Execute the following:
<nGenius install>/apache/bin/apachectrl start

3 Switch user to ngenius:
su - ngenius

4 Execute:
<nGenius install>/NewsStand/bin/nwsctl start

Note: If you need to stop the processes in the 
future, use the steps outlined above, substituting 
stop for start.

Solaris platforms only: An error occurs 
when sending v1.4 NewsPapers to a 
v2.0.1 NewsStand. (14798)

Before performing this procedure, you must 
have modified your v2.0.1 start script to 
create the NSNewsStand.exe process. Refer 
to the instructions contained in the "Using 
NewsPapers in a Mixed Environment" section 
of the nGenius Performance Manager v2.0.1 
Release Notes.

On the NewsStand Server, manually edit the 
classpath as follows:

1 Navigate to the rtm/bin directory and open 
pm_env.sh.

2 Near the bottom of the file, locate the 
NEWSSTAND_CLASSPATH variable.

3 Add the following to the end of the 
classpath:

:$NSJARS/thin.jar

4 Restart the server.
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During a remote UNIX installation (login 
with GUI, not Console), the DISPLAY 
environmental variable is reset back to 
the host machine before license 
information is entered. (13445)

The installation was successful. Go to the bin 
directory and run ./LicenseCL.sh to complete 
the licensing step.

Browser and Home Page 

Using Netscape v7.0 on Windows 
systems, if you exit the Home page 
window without logging out, you are still 
logged in to nGenius Performance 
Manager. 

Perform the following steps:

1 In a Netscape browser window, select Edit 
> Preferences. 

2 Follow the tree to select Advanced > 
HTTP Networking. 

3 Deselect Enable Keep-Alive in both the 
Direct Connection Options and the Proxy 
Connection Options.

nGenius Console

The leap year date of Sunday, February 
29 is missing from the graph. (15951)

This is caused by a bug in the third-party 
charting software JChart. 

For DLCI or DLCI QOS interfaces, the "> 
1518" counter is missing for Packet Size 
Distribution views. (15915)

Launching the Link Usage over Time view on 
a DLCI or DLCI QOS interface and selecting 
the Show > Packet Size Distribution option 
fails to display the "> 1518" counter, even 
though the counter displays in the Segment 
Details view for the same interface. This is a 
known issue. 

If you remove a Local Server from a 
Global Manager, and then re-add it, the 
original workspaces on the Local Server 
are no longer viable. (13197)

To recreate a workspace in its original form 
after re-adding a monitored element or Local 
Server (with its monitored elements), you 
must relaunch the relevant views and save 
the workspace. 

Trace files uploaded in *.cap format 
display incorrect timestamps. (15454)

This is a known issue.

Saving the Decode view as an Image. 
(9835)

The entire view (internal frame) is saved. 
The area of interest must be visible in the 
decode view in order for it to display in the 
saved image.

Table 10  Known Issues in nGenius Performance Manager v2.0.1 SP1 (Continued)

Issue Description
nGenius Performance Manager v2.0.1 Service Pack 1 Release Notes 37



On MIB2 device interfaces, when the 
duplex mode on an interface cannot be 
learned, the mode is set to the default 
(full-duplex). If this is set incorrectly, 
Total Utilization is incorrect. (11264)

To change the duplex mode:

1 From the Home page, select Server 
Administration.

2 From Device Configuration, select the 
interface and click Details.

3 Specify whether the interface is full duplex 
by selecting or deselecting the check box in 
the Fdx column.

When the correct duplex mode is set, the 
correct total utilization displays.

Note: The setting must match the router setting 
(full-duplex or half-duplex).

nGenius Server

MIB2 device Learn does not indicate 
conditions which result in unsupported 
interfaces. (15366)

Identifying the condition in the interface 
would save valuable debugging time. This is 
a known issue.

In a many-to-one configuration, the 
Global Manager cannot communicate 
with Local Servers when separated by a 
firewall. (14385)

Reconfigure your firewall to a one-to-one 
mapping rather than many-to-one mapping.

In Device Configuration > Details, the 
DLC and MIB2 radio buttons do not 
display for Cisco Catalyst5000 switches. 
(14196)

MIB2 polling is not supported for Cisco 
Catalyst5000 switches. Only DLC 
(mini-RMON) statistics are polled and logged.

To span switch ports in an Extreme 
switch, you must manually set the 
mirroring port in the Extreme switch via 
CLI. (13298)

This is a known Extreme switch limitation.

In a Distributed Server environment 
when you create a Forecast template on 
one server, the template does not display 
on other servers. (12398)

Refresh the view to display the template on 
other servers.

In a distributed server environment users 
with permission to login to the Local 
Server on the Global Manager cannot 
login (15810)

In order to access the local server on the 
Global Manager box you need to use the 
following link:

http://<server>:<port>/local-server.html
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During a database restore the database 
may go into recovery mode resulting in 
the inability to stop the database. 

Check the MasterCare Portal for the latest 
details on this issue.

Reporting

Renaming a Global NewsPaper in the 
NewsEditor fails to rename the 
NewsPaper in the Local Servers. (16081)

This issue will be addressed in a future 
release.

For IBM-AIX clients using Netscape 
Navigator, viewing Ad Hoc Reports using 
Adobe Acrobat fails to display colors 
properly.(15479)

Refer to "Displaying Colors on IBM Clients" 
on page 29 for workaround details.

Packet Analyzer

ATM and Wan (Cisco HDLC) capture in 
Raw_Header On upload as *.cap when 
put in Sniffer Pro 4.75 cannot be 
decoded. (16237)

This is a known issue.

Active Agent and Active Agent Manager

If the Active Agent Manager connects to 
the Active Agent, but later connectivity 
fails, the view does not repaint when 
adding or modifying a test for that Active 
Agent. (14658)

Windows platforms — Refresh the browser. 

UNIX platforms — Perform the following:

1 Close the Active Agent Manager browser 
window.

2 From a terminal, navigate to the <nGenius 
install>/activeagentmgr/bin directory.

3 Enter ./aamctl restart and press Enter.

4 Within the nGenius Performance Manager 
interface, click the Active Agent Manager 
icon. 

When you launch the Active Agent and 
then minimize it, you cannot then launch 
the Active Agent again using the icon. 
(13889)

Redisplay the Active Agent by maximizing 
the minimized window.

After adding new Active Agent 
eCommerce tests, the test list does not 
repaint. (13479)

1 Refresh your browser.

2 Select the Active Agent to which the test 
was directed, and click View Tests.
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Resolved Issues
Table 11  Issues Resolved in Service Pack 1

Number Description

nGenius Server

15749 Starting the nGenius Server through the Start menu no longer causes 
database loss. The strtserv.bat file has been modified so that it no longer 
creates a new database when started.

15365 Service Pack 1 manages table sizes for v6.0.0 probes successfully.

15183 MIB2 monitoring on GigE links with 15 minute intervals set no longer gets 
wrong bps rates. 

15178 Extremely large Host utilization logged to database is now corrected. 

15176 SNMP Trap Receiver replacement no longer overwrites trap settings in 
switches.

15154, 
15747

Weekly database backup now completes successfully.

14987 The dvTool functionality is no longer associated with nGeniusCLI. Therefore, 
failure of nGeniusCLI dvtool wrapper to create domain.lst is no longer 
pertinent.

14976 Problems relating to having two or more physical interfaces with the same 
DLCI number (duplicate DLCI in router) are resolved.

14728 Help now works properly in Global Settings.

14311 After the property to show all interfaces was put in serverprivate.properties 
file, all interfaces displayed. 

14065 Formerly, there were six buckets for Response Time. Because one bucket is 
designated for Retries, there are now five boundaries and six buckets.

Console

16008, 
15968

The Response Time menu option is no longer disabled for nFD ifn2 in MON 
mode.

15918 Abnormally high values no longer display in Conversations views. 

15274 All alarms in the alarm viewer can now be deleted.
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15082 Images are now saved as JPEGs rather than as GIFs. The Save as GIF menu 
option is now renamed to Save as an Image. 

14992 Baselines in bit rate graphs now display correctly (In/Out, not just In).

14853 Having a username containing a $ no longer prevents packet capture.

13446 A Could Not Read Preferences error on the Home page no longer prevents 
the Server or Console from launching. 

Reporting

15991 Switch port drill downs in NewsPaper now display In and Out instead of Total 
when supported.

15707 There is no longer a hard limit of 100 NewsPapers enforced by the 
NewsEditor.

15663 Capacity Planning detailed listing (for example, Frame Relay Circuits 
Detailed Listing) articles now retain the 15-minute logging interval selection. 
The logging interval no longer resets to hourly.

15531 Most Active Applications no longer shows the same protocol multiple times.

15315 The last column of a table is no longer omitted when creating a NewsPaper 
PDF.

15023 Ether2 and SNAP have been removed from the protocol directory.

14982 Double count for Most Active Applications and Most Active Network Protocols 
articles (Enterprise) is resolved. This occurred when both physical and 
virtual interfaces were included in the article. Now the Enterprise Wide Most 
Active Applications and Most Active Network Protocols articles include 
physical interfaces only.

14953 The Application Volume can now be generated for both physical interfaces 
and virtual DLCI, PVC, and VLAN interfaces.

14008 Adjustments to baseline percentile and legend were not reflected in 
NewsPaper articles after dataanalysis.properties was modified. Changes to 
dataanalysis.properties now display correctly in NewsPaper articles.

13996 Frame Relay Group for Most Utilized Circuits displays in article as expected.
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Related Information Resources

NetScout® Systems provides the documentation listed in the following table to 
support nGenius Performance Manager software and related hardware.

Refer to the proper manual or the online Help for detailed information about 
specific features and functions. This document assumes that you have already 
installed NetScout probes.

Document Description

nGenius Performance 
Manager Installation Guide

Explains how to get the nGenius Performance 
Manager software installed and running on a 
server.

nGenius Planning and 
Migration Guide

Provides information on how to migrate from:

• nGenius Performance Manager 1.4 to 
nGenius Performance Manager 2.0.1

• NSP 5.x to NSP 6.0.1 probe agent 
firmware

nGenius Configuration 
Essentials

Provides instructions for setting up, 
navigating, and interpreting key elements of 
the nGenius environment.  This guide also 
gives you a roadmap to architectural 
highlights, concepts, applications, and the 
best use of the most important features. 

nGenius Performance 
Manager Administrator 
Reference Guide

Provides information to configure the 
nGenius Server, NewsPapers, Active Agents, 
packet analysis, and Voice over IP (VoIP). 
Reference information is also included.

Note: The web version of the nGenius Performance 
Manager Administrator Reference Guide on the 
MasterCare Portal is updated with the latest release 
information.

Online Help Contains information on configuring and 
using nGenius Performance Manager 
software. Also included are instructions for 
customizing the software.

Probe documentation Contains detailed information on installing, 
configuring, and using NetScout probes. Visit 
the NetScout Systems website at 
www.netscout.com for a detailed listing.
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If you are a NetScout MasterCare customer, you can access nGenius 
Performance Manager documentation online in PDF format from the NetScout 
Systems website at www.netscout.com

Note: You must have Adobe Acrobat Reader on your system to view PDF 
files.
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